.
@ Network Printing Guide

“n

For safety, please read this manual carefully before you use this product and keep it
handy for future reference.




Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
e NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-
tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.
PostScript is a registered trademark of Adobe Systems, Incorporated.
Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

» Microsoft® Windows® 95 operating system

» Microsoft® Windows® 98 operating system

e Microsoft® Windows® Millennium Edition

* Microsoft® Windows® 2000 Professional

*  Microsoft® Windows® 2000 Server

e Microsoft® Windows NT® Server operating system Version 4.0

» Microsoft® Windows NT® Workstation operating system Version 4.0



Manuails for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

% Quick Installation Guide
Describes how to install the printer.

< Setup Guide
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

« Printer Reference
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Operating Instructions”.

« Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Operating Instructions” (this manual).

< PostScript 3 Operating Instructions Supplement

Describes the menus and features you can set using the PostScript 3 printer
driver. This manual is provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

& Note
O There are three CD-ROMs that come with this printer. "Operating Instruc-

tions", "Printer Drivers and Utilities", and "Document Management Utility".

O Concerning UNIX information, please visit our web site or consult your au-
thorized reseller.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

N\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be

damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

& Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's control panel.
Keys on the computer's keyboard.



This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Windows 2000,
Windows NT (Server

‘ NetWare (Server)

Windows 95/98/Me ‘ /\\

Windows 2000 .§ ) - /\
Windows NT ii
NetWare @ /
(Client) \a <

N l
acintosn ji

ﬂlmportant

O The procedures written in this manual assume that you are a network admin-
istrator. If you are not, be sure to consult your network administrator before
configuration.

/O Reference

For more information about configuring the Network Interface Board with
the control panel, see the Setup Guide.

< Features
¢ Support for 100BASE-TX, 10BASE-T and IP over 1394

* The Network Interface Board is compatible with NetWare (IPX/SPX,
TCP/1IP), Windows NT 4.0 (TCP/IP, NetBEUI ?, IPP 2 ), Windows 2000
(TCP/IP, NetBEUI !, IPP 2), Windows 95/98/Me (TCP/IP, NetBEUI 1,
IPP *2), UNIX (TCP/IP) and Macintosh (AppleTalk) protocols. This allows
you to use the machine in a network that uses different protocols and op-
erating systems.

* A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

e The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

"I To use NetBEUI, use the SmartNetMonitor for Client port.
IPP (Internet Printing Protocol) is a protocol for printing via the Internet.



Setting Up the Machine on a Network

Windows 95/98/Me

For setting up the machine as a network printer in a Windows 95/98/Me envi-
ronment, see p.1 “Windows 95/98/Me Configuration”. There are two methods
for using the machine as a network printer.

«Printing Without a Print Server «Printing With a Windows 2000 or
Windows NT Print Server

Windows 2000 or

Windows NT Server

(or Workstation)

Print Server

TCP/P
NetBEUI
PP

S i

Windows 95/98/Me Windows 95/98/Me



Windows 2000

For setting up the machine as a network printer in a Windows 2000 environ-
ment, see p.13 “Windows 2000 Configuration”. There are two methods for using
the machine as a network printer.

«Printing Without a Print Server «Printing With a Windows 2000 or
Windows NT Print Server

Windows 2000 or

Windows NT Server

(or Workstation)

Print Server

TCP/IP
NetBEUI
PP

LPR

J J

Windows 2000 Windows 2000

Windows NT 4.0

For setting up the machine as a network printer in a Windows NT 4.0 environ-
ment, see p.25 “Windows NT 4.0 Configuration”. There are two methods for us-
ing the machine as a network printer.

«Printing Without a Print Server “Printing With a Windows 2000 or
Windows NT Print Server

Windows 2000 or

Windows NT Server

(or Workstation)

Print Server

TCP/IP
NetBEUI
IPP

J I

Windows NT 4.0 Windows NT 4.0



Vi

NetWare

For setting up the machine as a network printer in a NetWare environment, see
p-39 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.
e Windows 95/98/Me = p.58 “Windows 95/98 /Me”

¢ Windows 2000 = p.59 “Windows 2000”

¢ Windows NT 4.0 = p.60 “Windows NT 4.0”

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

Print Server NetWare
File Server

S ]
N~ 2 N~
Windows 95/98/Me Windows 2000 Windows NT 4.0

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x = p.44 “Setting Up as a Print Server”
* NetWare 4.x,5/5.1 = p.51 “Setting Up as a Print Server”



Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

Remote Printer NetWare NetWare
Print Server File Server
I &
S S

~> ~> ~>
B @ g
Windows 95/98/Me Windows 2000 Windows NT 4.0

The actual procedures for configuring the machine depend on the NetWare ver-
sion.
¢ NetWare 3.x = p.47 “Setting Up as a Remote Printer”

* NetWare 4.x,5/5.1 = p.55 “Setting Up as a Remote Printer”

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p-61 “Macintosh Configuration”.

AppleTalk

S

Macintosh

Vii



UNIX

Concerning UNIX printing information, please visit our Web site or consult your
authorized reseller.

TCP/IP

UNIX

Viii
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1. Windows 95/98/Me

Configuration

Configuring Windows 95/98/Me

Printing without a Print Server

The following procedure describes how to configure Windows 95/98 /Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows NT Server, Windows NT Workstation, or NetWare based
print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP NetBEUI
[ 2. Configure the chosen protocol J

"Configuring NetBEUI

D "Configuring TCP/IP and IPP for Printing" for Printing"

[ 3. Select the appropriate software ]

If using the printer...

SmartNetMonitor
for Client

{ 4. Install the software and set the printer driver port J

8

"Using SmartNetMonitor
for Client"

Printing with a Windows 2000 or Windows NT Print Server

See p.10 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000 or Windows NT print server.



Windows 95/98/Me Configuration

Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

A Reference
For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.92 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Enable the use of the command prompt as follows:

e On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [Command Prompt].

e On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring Protocols

Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

ﬂ Open [Control Panel] and then double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

& Note
O If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the TCP /IP protocol, see
Windows 95/98/Me Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI” is listed in the [The following network components are installed:]
box on the [Configuration] tab.

& Note

O If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab
to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

O If “NetBEUI —Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.




Windows 95/98/Me Configuration

ﬂ Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and then click [Properties].

B Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
then click [OK].

ﬂ Click [OK] to close the [Network] dialog box.

B When the message to restart appears, click [Yes].



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.



Windows 95/98/Me Configuration

Installing SmartNetMonitor for Client

For more information about installing SmartNetMonitor for Client, see the Setup
Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. = p.7 “Setting Up the Printer Driver”

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Details] tab, and then make sure that the SmartNetMonitor for
Client port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port] box, select [FILE].
O ciick [Delete Port].

B Click the SmartNetMonitor for Client port name as in step ], and then click
[OK].

The port is deleted.
B Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The SmartNetMonitor for Client settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

g On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and then click
[Add/Remove].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.



Using SmartNetMonitor for Client

ﬂ After the confirmation message, click [Yes].
B Acknowledge the [Question] dialog box.
E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click [SmartNetMonitor] from the list, and then click [OK].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used.
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NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be displayed.
To print to a printer not listed here, click [Specify Address], and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For more information about the printing of the configu-
ration page, see “Printing a Configuration Page” in the Setup Guide. The
NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration
page. Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.
If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these settings, see SmartNetMonitor for
Client Help.

A ciick [ox.
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-

lowing Port] box, and then click [OK].
This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.



Using SmartNetMonitor for Client

Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

O You can configure Timeout Settings for the TCP/IP protocol.

ﬂ From the [Printers] window, click the printer icon. On the [File] menu, click
[Properties].

g Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.

When using a Windows 2000 or Windows NT print server, select a shared print-
er on Windows 2000 or Windows NT.

Windows 2000 or
Windows NT Print Server

aG

g :’

@
Windows 95/98/Me

? Limitation

O When using a print server connected to the printer with Ridoc IO Navi, you
cannot use Recovery Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

ﬂ Install the printer driver as a local printer.

p Reference

For more information about installing the printer driver, see the Setup
Guide.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].



Setting Up a Client Computer

ﬂ Click the [Details] tab, and then click [Add Port].
B Click [Network], and then click [Browse].

E On the network tree, double-click the name of the computer used as the
print server.

The printers connected to the network are displayed.
ﬂ Click the name of the printer you want to use, and then click [OK].
B click [0k

ﬂ Make sure that the port name is displayed in the [Print to the following port]
box, and then click [OK].

11
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S
2. Windows 2000

Configuration

Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP NetBEUI
[ 2. Configure the chosen protocol J
" I L "Configuring NetBEUI
D Configuring TCP/IP and IPP for Printing D for Printing"
[ 3. Select the appropriate software ]

If using the printer...

SmartNetMonitor
for Client

[ 4. Install the software and set the printer driver port J

"Using SmartNetMonitor
for Client"

13
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Windows 2000 Configuration

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

& Note

O If a device model selection dialog box appears during the procedure to add
the standard TCP/IP port, select "RICOH Network Printer C Model".

Printing with a LPR Port

See p.22 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See p.23 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000 or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.92 “Using DHCP”.

& Note
O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

B Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

g Click [Local Area Connection]. On the [General] tab, click [Properties].

15
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B Make sure that the”Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

ﬂ Click [Local Area Connection]. On the [General] tab, click [Properties].

BMake sure that the”NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the NetBEUI protocol box if it is not already selected.
O If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.

17
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Installing SmartNetMonitor for Client

For more information about installing SmartNetMonitor for Client, see the Setup
Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. = p.19 “Setting Up the Printer Driver”

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
@ select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step [}

B Click [Delete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[m Click [Close] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and then click [Change/Remove].

B After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Client.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver for the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.

Address: The IP address of the printer. 19
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B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be displayed.
To print to a printer not listed here, click [Specify Address] and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For information about the printing of the configuration
page, see "Printing a Configuration Page" in the Setup Guide. The Net-
BEUI address appears as "\ \RNPxxxx\xxx" on the configuration page.
Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@® To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
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O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [0k

ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].
This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears

¢ For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-
ing and Timeout Settings.

¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note

O For more information about these settings, see SmartNetMonitor for Client
Help.

2]
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

@ Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.15 “Configuring TCP/IP
and IPP for Printing”.

B cick [Start], point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab and click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled. For more information about how to install "Print Services for Un-
ix", see Windows 2000 Help.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

 click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].



Setting Up a Client Computer

Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.

When using a Windows 2000 or Windows NT print server, select a shared print-
er on Windows 2000 or Windows NT.

Windows 2000 or
Windows NT Print Server

@
Windows 2000

? Limitation

O When using a print server connected to the printer with Ridoc IO Navi, you
cannot use Recovery Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.
B cick [Start], point to [Settings] and then click [Printers].

B) Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Next >].
ﬂ Click [Network printer], and then click [Next >].
B Click [Next >].

E In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

23
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ﬂ Click the printer you want to use, and then click [Next >].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

O There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

B Select whether to use this printer as the default printer, and then click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



e
3. Windows NT 4.0

Configuration

Configuring Windows NT 4.0

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

D indicates topics explained in this document

[1. Specify the protocol to use J
Consult your network administrator about which of the three protocols is appropriate.
TCP/IP IPP NetBEUI
[ 2. Configure the chosen protocol J
" I L "Configuring NetBEUI
D Configuring TCP/IP and IPP for Printing D for Printing"
[ 3. Select the appropriate software ]

If using the printer...

SmartNetMonitor
for Client

[ 4. Install the software and set the printer driver port J

"Using SmartNetMonitor
for Client"

25
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Printing with a LPR Port

See p.35 “Configuring LPR Port Printing” for how to configure a LPR port in
Windows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See p.36 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000 or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.92 “Using DHCP”.

& Note
O After setting the IP address, use the ping command to make sure that it has
been correctly set.

@ Click [Start], point to [Programs], and then click [Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “TCP/IP Protocol” is listed in the [Network protocols] box on the [Proto-
cols] tab.

@ Note

O If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.
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ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

B Click the [Services] tab, and then make sure that “Microsoft TCP/IP Print-
ing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, to install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and then change the
LAN adapter number (Lana Number).

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI Protocol” is listed in the [Network Protocols] box on the [Proto-
cols] tab.

@ Note

O If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

g Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and then click [Properties].

B Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and then click [Edit].
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ﬂ Type “0” as the Lana Number.

& Note

O If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number a number other than “0”.

B click [0k
E Click [Close], and then close the [Network] dialog box.
ﬂ After checking the message to restart, click [Yes].

& Note
O After you change the Lana Number, you must restart the computer.

29
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Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.

? Limitation

O On a computer that is used as a print server, do not use the features such as
Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see SmartNetMonitor for Client Help.
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Installing SmartNetMonitor for Client

For more information about installing SmartNetMonitor for Client, see the Setup
Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. = p.32 “Setting Up the Printer Driver”

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port] box, select [FILE].

A click [Apply].
The port which is currently in use is changed.

B ciick [pelete Port].

E After the confirmation message appears, click [Yes].
The port is deleted.

ﬂ Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

¢ The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ On the [Install/Uninstall] tab, click [SmartNetMonitor for Client] and click [Add/Re-
move].
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B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

ﬂ After a confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor] from the list, and then click [New Port...].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.
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NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be displayed.
To print to a printer not listed here, click [Specify Address] and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For information about the printing of the configuration
page, see "Printing a Configuration Page" in the Setup Guide. The Net-
BEUI address appears as "\ \RNPxxxx\xxx" on the configuration page.
Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

@ If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [ox.
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].

This completes the settings.

To print, select the printer specified here. SmartNetMonitor for Client will
now direct print data to the printer automatically.
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Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server settings and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Port Configuration].
The [Port Settings] dialog box appears
e For TCP/IP protocol, you can configure Recovery Printing, Parallel Print-
ing and Timeout Settings.
¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.



Configuring LPR Port Printing

Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

@ Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see p.27 “Configuring TCP/IP
and IPP for Printing”.

B cick [Start], point to [Settings], and then click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

& Note
O If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd] box.

B Type “lp” into the [Name of printer or print queue on that server] box, and then
click [OK].

 click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.

When using a Windows 2000 or Windows NT print server, select a shared print-
er on Windows 2000 or Windows NT.

Windows 2000 or
Windows NT Print Server

aG

(7]
N
Windows NT 4.0

? Limitation

O When using a print server connected to the printer with Ridoc IO Navi, you
cannot use Recovery Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.
B cick [Start], point to [Settings], and then click [Printers].

B) Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Network printer server] and click [Next >].

ﬂ In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.



Setting Up a Client Computer

B Click the printer you want to use and click [OK].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK] and follow the instruc-
tions on the screen.

O There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

E Select if you want to use this printer as the default printer, and then click
[Next >].

[ After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.
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e
4. NetWare Configuration

This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

& Note

O NetWare must be set to active using the machine's control panel. For more in-
formation about how to set it, see the Setup Guide.

Installing the NIB Setup Tool

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartNet-
Monitor for Admin, and how to run the NIB Setup Tool.

? Limitation

O The NIB Setup Tool is supported to work with the following operating sys-
tems.
* Microsoft Windows 95/98/Me
* Microsoft Windows 2000
* Microsoft Windows NT 4.0

+ SmartNetMonitor for Admin
Using a printer in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

& Note

O If you configure the NetWare printing environment by using SmartNet-
Monitor for Admin under the following environments, NetWare Client
provided by Novell is required.

e NDS mode in Windows 95/98
¢ NDS or Bindary mode in Windows 2000/ Windows NT 4.0

< Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected
to the network.
If you cannot find out the printer from the displayed list, refer to the config-
uration page printed from the printer. For more information about printing a
configuration page, see the Setup Guide.
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Installing SmartNetMonitor for Admin

Install SmartNetMonitor for Admin on your computer. For the installation pro-
cedure, see the Setup Guide.

After installing SmartNetMonitor for Admin, see one of the following sections:

¢ To configure the Network Interface Board as a NetWare print server for the
first time, see p.41 “Quick Setup Using the NIB Setup Tool Wizard”.

¢ To use this computer with NetWare 3.x as a print server, see p.44 “NetWare
3.x - Advanced Settings”.

¢ To use this computer with NetWare 3.x as a remote printer, see p.44 “Net-
Ware 3.x - Advanced Settings”.

* To use this computer with NetWare 4.x, 5 or 5.1 as a print server, see p.50
“NetWare 4.x,5/5.1 - Advanced Settings”.

* To use this computer with NetWare 4.x, 5 or 5.1 as a print server, see p.50
“NetWare 4.x,5/5.1 - Advanced Settings”.

Running the NIB Setup Tool

I] Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
NetMonitor for Admin] program folder.
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Quick Setup Using the NIB Setup Tool
Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment.

p Reference

For more information about installing the NIB Setup Tool, see p.39 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see p.44 “NetWare 3.x - Advanced
Settings” or p.50 “NetWare 4.x, 5/5.1 - Advanced Settings”.

@ Note

O This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

O If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

* Windows 95/98/Me in NDS mode configuration
Windows NT 4.0 in NDS mode configuration
e Windows NT 4.0 in Bindery mode configuration

¢ Windows 2000 in NDS mode configuration
¢ Windows 2000 in Bindery mode configuration

ﬂ Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

ﬂ Run the NIB Setup Tool.

/O Reference
= p.40 “Running the NIB Setup Tool”

B Click [Wizard] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B click [IPX protocol].
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B Click to select the IPX address of the Network Interface Board you are con-
figuring, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
print a network configuration page to check the MAC address (Network
address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].
ﬂ Type the print server name into the [Device Name] box, and then click [Next >].

The default setting is “RDP_" followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

8 In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

B Click [Next >].
A dialog box for configuring the NetWare environment appears.

[E Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

ﬂ] If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

[ﬂ If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and then type the context into the [Con-
text:] box.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

B click [Next >].
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m Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1"
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.

[B If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box.

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

0 click [Next >].
A dialog box to acknowledge the printing environment appears.

m After checking the environment, click [Next >].
If you want to change the settings, click [< Back], and then make the settings
again.
Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

iE After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board ]

(Configure the NetWare )

v

5] Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. = p.41 “Quick Setup Using the NIB Setup Tool Wizard”

Start the print server

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.

g Run the NIB Setup Tool.

A Reference
= p.40 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B click [IPX protocol].
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B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.
@ Select [Bindery].

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

@ Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

m Create a print queue as follows:

& Note
O If you use a currently defined print queue, go to step (B.

@ From the [Available Options] menu, select [Print Queue Information], and then
press the [ENTER] key.

@ Press the [INSERT] key, and then type a print queue name.
@ Press the [ESC] key to return to the [Available Options] menu.
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[B Create a printer as follows:

@ From the [Available Options] menu, select [Print Server Information] , and then
press the [ENTER] key.

@ To create a new print server, press the [INSERT] key, and then type a
print server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

ﬂlmportant
O Use the same name as that specified in the NIB Setup Tool. ( Step B).
@ From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.
@ 1f you want to change the name of the printer, type a new name.
A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.
@ For type, select [Remote Other/Unkown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and then click [Yes] in the confirmation dialog box.
@ Press the [ESC] key to return to the [Print Server Configuration] menu.

[ﬂ Assign print queues to the created printer as follows:
@ From the [Print Server Configuration] menu, select [Queues Serviced By Printer].
@ Select the printer created in step [B.
@ Press the [INSERT) key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

@ Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, make sure that the queues are
assigned.

[BPress the [ESC] key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

@ Note

O To make sure that the printer is correctly configured, type the following
from the command prompt.

F:> USERLIST

O If the printer works as configured, the name of the print server appears as
an attached user.
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Setting Up as a Remote Printer

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run the NIB Setup Tool.

p Reference
= p.40 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see a network configuration page to check the MAC address (Network Ad-
dress).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Server Name] box, type the name of the print server.

In the [File Server Name] box, type the name of the file server in which a
) ¢ YP
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

© In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, type the printer number.

ﬂlmportant
O Use the same printer number as that to be created in the printer server.

@ Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].
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[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

m Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

m Create a print queue as follows:

& Note
O If you use a currently defined print queue, go to step (B.

@ From the [Available Options] menu, select [Print Queue Information], and then
press the [ENTER] key.

@ Press the [INSERT) key, and then type a print queue name.
@ Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows.

@ From the [Available Options] menu, select [Print Server Information] , and then
press the [ENTER] key.

@ To create a new print server, press the [INSERT] key, and then type a
print server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

i@klmportant
O Use the same name as that specified in the NIB Setup Tool. (Step B).

@ From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

i@klmportant
O Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step B-@).
O Type a new name, if you change the name of the printer.

A name “Printer x” is assigned to the printer. x stands for the number of
the selected printer.

@ Select [Remote Parallel, LPT1] for type.

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and then click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menu].
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m Assign print queues to the created printer as follows:
@ From [Print Server Configuration Menu], select [Queues Serviced By Printer].
@ Select the printer created in step {B.
@ Press the [INSERT) key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

@ Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

[BPress the [ESC] key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

[E Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.
% To exit

CAREE: unload pserver
% To start

CAREE: load pserver print server name

& Note
O If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1 environ-
ment.

< To use NetWare 5/5.1

¢ If you use Pure IP, configure the machine to use the TCP/IP protocol. For
more information about how to make the settings, see the Setup Guide.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board ]

(Configure the NetWare )

v

5] Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. = p.41 “Quick Setup Using the NIB Setup Tool Wizard”

Start the print server

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

O You should install the client software released from Novell in Windows be-
fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.
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Setting Up as a Print Server

ﬂlmportant

O You can set up the print server using the NDS or Bindery mode in NetWare
4.x,5/5.1. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. = p.41 “Quick Setup Using the
NIB Setup Tool Wizard”.

& Note

O If you use Pure IP in NetWare 5/5.1, follow the procedure on p.53 “Using
Pure IP in the NetWare 5/5.1 environment”.

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

/O Reference
= p.40 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].
B click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.

@ In the [Print Sever Name:] box, type the name of the print sever.

@ In the [File Sever Name:] box, type the name of the file sever in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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© In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

@ Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
ﬂ] From Windows, run NWAdmin.

p Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

m Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and then click [OK].
© In the [Print Queue name] box, type the name of the print queue.
@ In the [Print Queue volume] box, click the [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

O After checking the settings, click [Create].

[B Create a printer as follows:

@ Select the container object the printer is located in, and then click [Create]
on the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and then click [OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.

© In the [Printer name] box, type the name of the printer.
@ Select the [Define additional properties] check box, and then click [Create].

m Assign print queues to the created printer as follows:

@ Click [Assignments], and then click [Add] in the [Assignments] group.
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@ In the [Available objects] box, click the queue created in step @, and then
click [OK].

@ Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

@ Click [Manual load] in the [Communication type] group, and then click [OK].
@ After checking the settings, click [OK].

[B Create a print server as follows:

@ Select the context specified using the NIB Setup Tool (step @-@), and
on the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and then click [OK].
When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

@ In the [Print Server name] box, type the name of the print server.

i@klmportant
O Use the same name as that specified using the NIB Setup Tool. (Step @)

@ Select the [Define additional properties] check box, and then click [Create].

[E Assign the printer to the created print server as follows.
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the printer created in step @, and then
click [OK].

© After checking the settings, click [OK].

& Note

O If the printer works as configured, the name of the print server appears
as an attached user.

Using Pure IP in the NetWare 5/5.1 environment

ﬂ Log on to the file server as an Admin or an Admin equivalent.
g Run the NIB Setup Tool.

A Reference
= p.40 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].
The [Network board list] dialog box appears.

ﬂ Click [TCP/IP protocol].
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B Click the IP address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note
O If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IP address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name:] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

© In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

@ In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[E On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
After this step, go to step ff] on p.51 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

p Reference
= p.40 “Running the NIB Setup Tool”

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

In the [File Server Name: bOX, ty e the name of the file server in which a
P
pl‘il‘lt server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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© In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.

As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

@ In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, type the number of the printer.

ﬂlmportant
O Use the same number as that of the printer to be created in the print
server.

O Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
m From Windows, run NWAdmin.

/O Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

m Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and then click [OK].
© In the [Print Queue name] box, type the name of the print queue.
@ In the [Print Queue Volume] box, click [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

O After checking the settings, click [Create].

[B Create a printer as follows:

@ Select the container object the printer is located in, and then click [Create]
in the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and then click [OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.
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© In the [Printer name] box, type the name of the printer.
@ Select the [Define additional properties] check box, and then click [Create].

[ﬂ Assign print queues to the created printer as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step @, and then
click [OK].

@ Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

@ Click [Manual load] in the [Communication type] group, and then click [OK].
@ After checking the settings, click [OK].

[B Create a print server as follows:

@ Select the context specified using the NIB Setup Tool (Step @-@), and
on the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and then click [OK].
When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.

ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step @).

@ Select the [Define additional properties] check box, and then click [Create].

m Assign the printer to the created print server as follows.
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in the step @, and
then click [OK].

© In the [Printers] group, click the printer assigned in step @ , and then
click [Printer Number].

O Type the printer number and click [OK].

ﬂlmportant
O Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step @-@).
@ After checking the settings, click [OK].

m Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.

< To exit
CAREE: unload pserver

% To start
CAREE: load pserver print server name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

& Note

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use as “Local printer”.

p Reference

For more information about installing the printer driver, see the Setup
Guide.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Add Port].

[ ciick [Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.

The queues are displayed.
B Click the queue you want to print, and then click [OK].

B click [ok.
In the [Print to the following port] box, a network path to the printer appears.

[m Click [OK] to close the Printer Properties, and again, open it.



Setting Up a Client Computer

B Click the [Printer Settings] tab.
m Select to clear the [Form feed] and [Enable banner] check boxes.

@ Note

O You should not select these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
@ Click the [PostScript] tab.
@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

[B Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.
B cick (No).
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

B The [Printer Installation] dialog box appears.

E From the [Port] list, select the queue you selected in step fJ, and then click
[Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B click Noj.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities”into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

B The [Printer Installation] dialog box appears.

B From the [Port] list, select the queue you selected in step f], and then click
[Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.
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5. Macintosh Configuration

Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Basic Procedure

Change to EtherTalk J

(
( Configure the printer )
(

Change the printer name]

Change the zone

Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

A Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

ﬂ Open [Control Panel], and then double-click the [AppleTalk] icon.

g From the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name from the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] control panels.

B Restart the Macintosh.
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Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

A Reference
For more information about configuration, see the Setup Guide.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printerl” and “printer2”.

To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

/O Reference

For more information about using Printer Utilities for Mac, see PostScript 3
Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.
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6. Appendix

Configuring the Network Interface Board
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

< Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

p Reference

For more information about configuring the machine to use the TCP/IP
protocol, see the Setup Guide.

< Operating system browser requirements

oS Browser
Windows 95/98/Me
Windows NT 4.0
Windows 2000

Mac OS 8.6 ~9.1
Solaris 2.5/2.6/2.7/7/8

? Limitation

O Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

O The text on the screen may disappear or be aligned incorrectly if the font
size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

Microsoft Internet Explorer 3.02 or later

Netscape Navigator 4.0 or later

O This machine information cannot reload automatically. Click [Reload] or
[Refresh] on the Web browser when you want to reload this machine infor-
mation.
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

@ Note

O If a DNS server is used on the network, you can type the host name as a URL.
For example, http:/ /webmonitor.netprinter.com/. In order to do this, you
must the register the IP address and the host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-

tion about how to do this.

O When you use the proxy server, you must set up the proxy server address for
the Web browser you are using. Consult the network administrator for infor-
mation about how to set the proxy server.

1. Header Buttons

You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

i@klmportant

O When connecting via a dial-up
connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

@ Note

O The Help files are stored on the CD-
ROM labeled “Operating Instruc-
tions” in HTML format.

2. Menu Buttons

These Buttons are to configure the Net-
work Interface Board and for checking
the status of the machine.

& Note

O When you click [Configuration], a dia-
log box appears requesting the user
name and password. Type only the
password in this dialog box. The de-
fault password is “password”.

O The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status

Displays the name and comments of the
Network Interface Board, and the printer
status.
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iQ'f‘Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.

@ Copy the Help files on the CD-ROM to the desired location. The Help files are
located in folders labeled with abbreviated language names; for example,
English Help files are in the [EN] folder. Make sure to copy the entire [EN] fold-
er to the new location.

® Using a Web Browser, navigate to the Top Page and click [Network config].
® Type your password, (it is not necessary to type a user name) and click [OK].

@ Type the path to the Help files in the [Help URL] box.
If you copied the Help files to “C:\HELP\EN", type “file:/ /C:/HELP/”. For
example if you copied the files to a Web server and the index URL is “ht-
tp://a.b.c.d/HELP/EN/index.html”, type “http://a.b.c.d/HELP/”.

® Click [Apply].
When a warning message appears, select to continue configuration.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

& Note

O You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote mainte-
nance.

Using telnet

The following is a sample procedure using telnet.

? Limitation

O Only one person at a time can be logged on to do remote maintenance.

ﬂ Using the IP address or host name of the machine, start telnet.

% telnet IP address

& Note

O In order to use the host name instead of the IP address, you must write it
to the hosts file.

g Type the password.

& Note
O The default is “password”.

B Type a command.

/O Reference
For more information about telnet commands, see p.67 “Commands List”.

ﬂ Exit telnet.
msh> logout

When the configuration is changed, a message requests whether or not the
changes should be saved.

B Type “yes” to save the changes, and then press the [ENTER] key.

If you do not want to save the changes, type “no”, and then press the [ENTER]
key. If you want to make additional changes, type “return” at the command
line, and then press the [ENTER] key.

@ Note

O If the “Cannot write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.
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O The Network Interface Board is reset automatically when the settings are
changed.

O When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

Use this command to display remote maintenance use.

& Note
O Type “help” to see a list of commands that can be used.

msh> help

O Type “help command_name” to display information about the syntax of that
command.

msh> help command name

TCP/IP address

Use the ifconfig command to configure TCP /IP(IP address, subnet mask, broad-
cast address, default gateway address) for the machine.

«» Reference
msh> ifconfig

< Configuration
msh> ifconfig interface name parameter address

Interface name Interface to be configured
ether Ethernet Interface ™

sie(

ip1394 2 IEEE 1394 Interface

fwip0 2

"I If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.
"2 Available when the 1394 Interface Unit Type 4510 is installed.

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address
broadcast broadcast address
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The following is an example for configuring an IP address of 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on
Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

@ Note

O This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

O To type an address using hexadecimal, prefix it by “0x”.

’iQ'FAddress

% Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

m < Default Gateway Address

A gateway is a connection or interchange point that connects two networks.
A gateway address is used as a gateway by the router or host computer .

& Note
O To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control. You can also
specify two or more access ranges.

+% Reference

msh> access

< Configuration
msh> access % range start-address end-address
* 3¢ represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)
Example: To specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range 192.168.0.10 192.168.0.20

& Note
O The entry is invalid if the start address is greater than the end address.

O Up to five access ranges can be specified. The entry is invalid if the target
68 number is omitted.
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< Access Control Initialization
msh> access flush

& Note

O This restores the factory-default settings so that all access ranges become
"0.0.0.0".

Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

“on” means active and “off” means inactive.

Parameter Meaning
dhcp DHCP (Dynamic Host Configuration
Protocol)
& Note

O When you use DHCP, the server also needs to be configured.
O DHCP takes precedence over all other settings.

Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}

Protocol

appletalk “up” means active and “down” means
tepip inactive.

netware

netbeui

scsiprint !
ip1394 1
lpr
ftp
rsh
diprint
web
snmp
ipp

"1 Available when the 1394 Interface Unit Type 4510 is installed.
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@ Note

O If you prohibit remote access using TCP/IP and then log out, you cannot use
remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

O When you prevent access via TCP/IP, you are also prevented from using
ip1394, lpr, ftp, rsh, diprint, web, snmp and ipp.

Printer status

The following commands can be used to get information about the current status
of the printer.

msh> command

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray,
printer language of printer.

prnlog [ID] Lists the last 16 print jobs.

& Note

O More information about any print job is displayed when the ID number is
added after the prnlog command.

p Reference

For more information about the meaning of the data returned with these com-
mands, see p.82 “Configuring the Network Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-p]

& Note

O Add “-p” to the show command to have the information displayed one screen
at a time.

/O Reference

For more information about the meaning of the data returned with this com-
mand, see p.82 “Configuring the Network Interface Board”.
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System log information

Use the syslog command to display information stored in the machine's system
log.

msh> syslog

A Reference

For more information about the displayed information, see p.85 “System Log
Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

The 1394 Interface Option Type 4510 supports TCP/IP only.

& Note
O You can configure from ten SNMP access settings numbered 1-10.

O Default access settings 1 and 2 are as follows.

Number 1 2
Community name public admin
IP address 0.0.0.0 0.0.0.0
Access type read-only read-write
trap off trap off
< Display

Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-pl [registered numberl]

& Note
O If the -p option is added, you can view the settings one by one.

O Omitting the number displays all access settings.

< Community name configuration
You can set the community name of the registered number.

msh> snmp number name community name

& Note
O The community name must consist of 15 characters or less.
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9
%

9
%

Access type configuration
You can select the access type from those listed below.
msh> snmp number type access type

Access type Type of access which is permitted
read Read only

write Read and write

trap User is notified of trap messages.
no All access is denied.

Protocol configuration
You should use the following command to set the protocols to active or inac-

tive. If you set a protocol to inactive, all access settings set to use that protocol
will be disabled.

msh> snmp {ip | ipx} {on | off}

* “on” means active and “off” means inactive

To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

Access configuration

You can configure the address of a host depending on the protocols used.
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:

msh> snmp number {ip | ipx} address

& Note

O To specity the TCP/IP protocol, type ip followed by a space, and then the
IP address.

O To specify the IPX/SPX protocol, type ipx followed by a space, and then
the IPX address followed by a decimal, and then the MAC address of the
Network Interface Board.

The following is an example of how to configure registration number 3 with

the IP address 192.168.15.16.

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with

the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.

msh> snmp 3 ipx 7390A448:000074625C65
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IPP

Use the ipp command to configure the IPP settings.

< Viewing setting
The following command displays the current IPP settings.

msh> ipp
Example output:

timeout=900 (sec)
auth basic

¢ The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection can
be made.

¢ The “auth” setting indicates the user authorization mode.

< IPP timeout configuration
Specify how many seconds to wait before canceling a print job if it has been

interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh> ipp timeout {30 - 65535}

< IPP user authorization configuration

Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “off” .

ipp auth {basic|digest|off}
e “basic” and “digest” are user authorization setting.

o “off” removes the user's authorization.

& Note

O If you select “basic” or “digest”, see next section “Entry the IPP User Au-
thorization” for how to configure the user name. Up to ten user names are
available.

« Configuring the IPP user authorization
Use the following command:

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:userl
IPP password:****k&%
After configuring the settings, the following message appears.

User configuration changed.
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Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.

Use the diprint command to change the direct printing port settings.

< View settings
Ther following command displays the current direct printing port settings.

msh> diprint
Example output:

port 9100
timeout=300 (sec)
bidirect off

¢ The “Port” specifies the port number of the direct printing port.

¢ The “bidirect” setting indicates whether the direct printing port is bidirec-
tional.

< Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.

msh> diprint bidirect {on|off}

& Note

O If you select “on”, SmartNetMonitor for Client or Standard TCP/IP on
Windows 2000 might not work correctly.

SMB

Use the smb command to configure or delete the computer name or workgroup
name for NetBEUL

msh> smb parameter

Parameter Settings

comp Your computer name consisting of up to 13 characters
group Workgroup name consisting of up to 15 characters
comment Comment consisting of up to 31 characters

clear comp Clears the computer name

clear group Clears the Workgroup name

clear comment Clears comment
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ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

& Note

O The maximum number of routing tables are 16.
Commands Topics of setting
route add {host | net} desti- | Adds a host/network route to “destination”, and a gateway ad-
nation ! gateway ! dress to “gateway” in the table. Host becomes the default setting.
route delete {host | net} Deletes a host/network route from the table. Host becomes the
destination " default setting.
route get {destination " } Displays only route information corresponding to a specified

destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des- | You can turn the specified destination on or off. Host becomes
tination "' on/off the default setting.

route flush Deletes all routing information.

I IP address

SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PurelP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

@ Note

O The default value of TTL is “1”. A search is executed only within a local seg-
ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

O The acceptable TTL value is 1 - 255.
msh> slp ttl {1 - 255}
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Job Spool

Use this command to configure Job Spool settings.

? Limitation

O You can only specify the LPR and IPP protocol.

& Note

O This machine information cannot reload automatically when you confirm the
Job spool settings on the Web browser. Click [Reload] or [Refresh] on the Web
browser when you want to reload this machine information.

“ Reference
The job spool setting appears.

msh> spoolsw

< Job Spool Setting

msh> spoolsw spool {on | off}

& Note
O Specify "on" to enable the job spool function or "off" to disable it.

< Clearing Spool Job
If the printer is turned off accidentally during a spool job, you can specify
whether the job will be reprinted when the printer is turned back on.

msh> spoolsw clearjob {on |off}

< Protocol Configuration
To change the protocol settings, use the following command. You can specify
the setting for [Ipr] or [ipp].

o Ipr

msh> spoolsw lpr {on |off}
* ipp

msh> spoolsw ipp {on |off}

Changing the Host Name

Use the hostname command to change the printer name.

msh> hostname [interface name ] printer name

interface name Interface to be configured
ether Ethernet interface ™
ip1394 2 IEEE 1394 interface

"I If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.
"2 If you install the 1394 Interface Option Type 4510, you can set the command.
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& Note
O Enter the printer name using up to 13 characters.

O You cannot use a printer name starting with RNP or rnp.

WINS

Use the wins command to configure the WINS server settings

For more information about WINS server settings, see p.92 “Configuring a
WINS Server”.

< Viewing setting
The following command displays the WINS server IP address.

msh> wins
Example out put:

wins: primary server 0.0.0.0 secondary server 0.0.0.0
DHCP current config:

primary server 192.168.10.1 secondary server
192.168.10.2

hostname RNP620B47 ScopelD

& Note

O If DHCP is used to start from the network, the current WINS server ad-
dress is displayed. This address, however, is not displayed if DHCP is not
used.

O If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

< Configuration
Use the set command to make WINS active or inactive.

msh> set wins {on|off}

¢ "on means active and "off" means inactive.

< Address configuration
Use this command to configure a WINS server IP address.

L)

msh> wins {primary|secondary} IP address

& Note
O Use the "primary" to configure a primary WINS server IP address.

O Use the "secondary " to configure a secondary WINS server IP address.
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AutoNet

Use the set command to configure AutoNet.

& Note
O For more information about AutoNet, see p.92 “Using AutoNet”.

msh> set autonet {on|off}

"on" means active and "off" means inactive.

SNTP

The printer clock can be synchronized with a NTP server clock using the Simple
Network Time Protocol (SNTP). To change the SNTP settings, use the sntp com-
mand. Confirm with the network administrator that the NTP server settings are
correct.

? Limitation

O SNTP supports the NTP servers running xnptd V3 and V4.

% Reference
msh> sntp

< NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP address

L)

« Interval Configuration
You can specify the interval at which the printer synchronizes with the oper-
ator-specified NTP server.
msh> sntp interval polling time

& Note
O The factory default setting is 3600 seconds.

O You can set the interval from 16 to 16384 seconds.

O If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

« Time-zone Configuration
You can specify the time difference between the printer clock and the NTP
server clock.

msh> sntp timezone +/—hour_ time
Example: To set the time-zone difference to +8 hours:

msh> sntp timezone +08:00

& Note
O The time is in 24-hour notation.
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Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default password is “password”.

ﬂ Type “passwd”.

msh> passwd

g Type the current password.
0l1ld password:

B Type the new password.

New password:

& Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

ﬂ Type the new password once again.

Retype new password:
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SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.

The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

/O Reference

You can configure SNMP from the command line using telnet. See p.71
“SNMP”.

You can configure SNMP from SmartNetMonitor for Admin using the NIB
Setup Tool. See Help for SmartNetMonitor for Admin.

You can configure SNMP from your Web browser. See Help on the CD-ROM.

? Limitation

O The kinds of supported MIBs vary depending on the printer.

< Supported MIBs
e MIB-II
® PrinterMIB
¢ HostResourceMIB
¢ RicohPrivateMIB
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Understanding the Displayed Information

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.

¢ telnet : Use the status command. = p.70 “Printer status”

Item name Meaning
Rank Print job status.
e Active
Printing or preparing for printing.
¢ Waiting
Waiting to be transferred to the printer.
Owner Print request user name.
Job Print request number.
Files The name of the document.
Total Size The size of the data (spooled).
The default is “0 bytes”.

Print Log Information

This is a record of the most recent 16 jobs that have been printed.

This log can be displayed with the following commands.

¢ telnet: Use the prnlog command. = p.70 “Printer status”

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Result The result of the print request.

Time The time when the print request was received

User ID " User ID that is to be configured in the printer driver.
JobName The name of the document for printing.

"1 Appears the UserID and JobName information when entering the info command
with the ID.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands
below.

¢ telnet: Use the show command. = p.70 “Network Interface Board configura-
tion settings information”

Item name Meaning

Common
Mode
Protocol Up/Down Up means active, Down means inactive.

AppleTalk

TCP/IP

NetWare

NetBEUI

IP over 1394 ™

SCSI print
Ethernet interface
NVRAM version Internal version number.

Device name

Comment

Location

Contact

Soft switch

AppleTalk
Mode AppleTalk protocol in selection.

Net Network number.
Object Macintosh printer name.

Type The type of printer.

Zone Name of the zone that the printer belongs to.




Understanding the Displayed Information

Access Range[+] ™
Time server
Time Zone

Time Server Polling Time

Item name Meaning
TCP/1P
Mode Up means active, Down means inactive.
ftp
lpr
rsh
diprint
web
telnet
snmp
ipp
EncapType Frame type.
Network boot Network boot.
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
Gateway Default gateway address.

Access Control Range
NTP server address
NTP server time difference

Synchronizes interval

Home page URL URL of homepage.

Home page link name URL name of homepage.

Help page URL URL of help page.

SNMP protocol Protocol used with SNMP.
NetWare

EncapType Frame type.

RPRINTER number Remote printer number.

Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation

Print job timeout

Print server name.
Name of the connect file server.
Context of print server.

Active mode.

(this value is fixed)

Time of the job timeout.
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Workgroup name
Computer name
Comment

Share name[1]

Item name Meaning
NetBEUI
Switch
Mode (this value is fixed)
diprint (this value is fixed)
Notification Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

Shell mode

Mode of the remote maintenance tool.

"I The 1394 Interface Option Type 4510 supports TCP/IP only.
"2 ¥< represents a target number between 1 and 5.




Message List

Message List

This is a list of messages written to the machine's system log. The system log can

be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

¢ telnet: Use the syslog command. = p.71 “System log information”

Message

Description and Solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print
server on the NetWare server or the password
was incorrect.

(In print server mode) Cannot log in to the file
server. Make sure that the print server is resis-
tered on the file server. If a password is speci-
fied for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists.
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>,
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is
TRAP. Specify the host IPX address for the
TRAP destination.

add_sess_ipx: community <community
name> already defined.

The same community name already exists.
Use another community name.

add_sess_ipx:session_ipx<community name>
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk)

An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name>

Attached to the file server as a nearest server.

Attach to print queue <print queue name>

(In print server mode) Attached to the print
queue name.

Cannot create service connection

(In remote printer mode) Cannot establish a
connection with the file server. The number of
file server users may exceed the maximum
number that the file server can handle.
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Message

Description and Solutions

Cannot find rprinter (<print server
name>/<printer number>)

The printer having the number displayed on
the print server does not exist. Make sure that
the number of the printer is registered in the
print server.

Change IP address from DHCP Server.

The IP address changes when DHCP LEASE is
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP serv-
er.

child process exec error! (process name)

Failed to start the network service. Turn the
printer off and then on. If this does not work,
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from
the DHCP server.

connection from <IP address>

Logged on from the host <IP address>.

Could not attach to FileServer<error number>

(In remote printer mode) Cannot attach to the
file server. For some reason, the file server
refuses the connection. Check the file server
configuration.

Could not attach to PServer<print server>

(In remote printer mode) Cannot attach to the
print server. For some reason, the print server
refuses the connection. Check the print server
configuration.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100 Mb-
ps).

Current IP address <current IP address>

The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address>

The current IPX address.

DHCP lease time expired. DHCEP lease time has expired. The printer tries
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure
the DHCP server is running on the network.

dhcped start. A dhcpced (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,
(RPSocket=<socket number>, connID=
<connection ID>)

(In remote printer mode) A connection with
the print server has been established.

exiting

Ipd service has ended and the system is exiting
the process.




Message List

Message

Description and Solutions

Exit pserver

(In print server mode) Exits the print server
because the necessary print server settings
have not been made.

Frametype =<frame type name>

The <frame type name> is configured to be
used on NetWare.

httpd start.

An httpd has started.

inetd start.

An inetd has started.

<interface> started with IP: <IP address>

<IP address> has been set for <Interface> and
<Interface> started.

<Interface>: Subnet overlap.

Subnet from Netmask and the IP address you
tried to set for <Interface> overlap the subnet
for another interface.

Set Subnet so that it does not overlap with an-
other interface.

IPP cancel-job: permission denied.

The printer could not authenticate the name of
the user attempting to cancel a job.

ipp disable.

Printing with ipp is disabled.

ipp enable.

Printing with ipp is enabled.

IPP job canceled. jobid=%d.

The spooled job has been canceled due to an
error or by user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from
the DHCP server is <lease time> in seconds.
The renewal time is also <renew time> in sec-
onds.

Login to fileserver <file server name>
(<IPX IIP>,<NDS | BINDERY>)

(In print server mode) Logged in to the file
server with NDS or BINDERY mode.

multid start.

Data transmission service for multiprotocols
has started.

nbstart start. (NetBEUI)

The service for NetBEUI protocol stack setting
has started.

NBT Registration Broadcast(<NetBIOS
name>)

Use alocal broadcast to map <NetBIOS name>
with the IP address.

nbtd start.

A nbtd (NetBIOS over TCP/IP Daemon) has
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer
name>

The NetBEUI Computer Name is defined as
<computer name>.

nmsd start. (NetBEUI)

A nmsd (Name Server Daemon) has started.

npriter start. (NetWare)

(In remote printer mode) NetWare service has
started.

nwstart start. (NetWare)

The service for NetWare protocol stack setting
has started.
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Message

Description and Solutions

Open log file <file name>

(In print server mode) The specified log file
has been opened.

papd start. (AppleTalk)

AppleTalk print service has started.

permission denied.

Job cancellation was determined to be unau-
thorized after checking the user name and host
address (except for ROOT authorization).

phy release file open failed.

Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be
serviced by printer 0, <print server name>

(In print server mode) The print queue name
cannot be serviced. Make sure that print queue
volume exists on the specified file server.

Print server <print server name> has no print-
er.

(In print server mode) The printer object is not
assigned to the print server <print server
name>. Using NWAdmin, assign the printer
object, and then restart the printer device.

Print session full

Cannot accept the print session.

Printer <printer name> has no queue

(In print server mode) The print queue is not
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare)

(In print server mode) NetWare service has
started.

Required computer name (<Computer
name>) is duplicated name

The same computer name is detected on the
network. The start job determines the compu-
ter name by adding the computer name to the
suffix (0,1....). Configure a new computer
name that is unique.

Required file server (<file server name>) not
found

Cannot find the required file server.

restarted.

LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP (SAP
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name>

A <NDS context name> has been set.

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI)

An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready.

Communication over TCP/IP with SNMP is
available.
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Message

Description and Solutions

Snmp over IP over 1394 is ready.

Communication over IP over 1394 with SNMP
is available.

Snmp over ipx is ready.

Communication over IPX with SNMP is avail-
able.

snmpd start.

SNMP service has started.

started.

Direct print service has started.

The print server received error <error
number> during attempt to log in to the net-
work.Access to the network was denied. Verify
that the print server name and password are
correct.

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without
specifying a password.

win2kspd protocol-DOWN (APPEXIT).

NVRAM setting ioctl (SPIO CAPPEXIT) of de-
vice SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.

win2kspd protocol-UP (APPENTRY).

NVRAM setting ioctl (SPIO CAPPENTRY) of
device SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.

win2kspd started.

SCSI print (SBP-2) service has started.

WINS name refresh :Server No Response

There has been no response to the update re-
quest from the server. Confirm that the WINS
server address is correct and the WINS server
is working properly.

WINS name registration:Server No Response

There has been no response to the registration
request from the server. Confirm that the
WINS server address is correct and the WINS
server is working properly.

WINS server address0.0.0.0

The WINS server address has not been speci-
fied. Specify the WINS server address to
match the printer name with WINS.

WINS Server=< WINS server address > NetBI-
OS Name=<NetBIOS name>

The printer name has been successfully regis-
tered in <WINS server address>.

WINS wrong scopelD

The scope ID is wrong.
Specify the correct scope ID.

write error occurred. (diskfull)

The hard disk became full while the spool file
was being written.

Wait until enough HDD space becomes avail-
able as printing proceeds.

write error occurred. (fatal)

A fatal error occurred while the spool file was
being written.

Turn the printer off and then on. If this does
not work, contact your service or sales repre-
sentative.
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

& Note

O The MAC address of the printer doing the filtering is printed on the printer
configuration page. For more information about printing a configuration
page, see the Setup Guide.

O For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

ﬂ Following the setup method in this manual, configure the file server.
g Set the frame type for a NetWare environment.

A Reference
For more information about selecting a frame type, see the Setup Guide.

Configuring the printer without NetWare

ﬂ While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

A Reference
For more information about selecting a protocol, see the Setup Guide.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Unit Type 1027
Operating Instructions Supplement provided as a PDF file on the CD-ROM la-
beled “Operating Instructions”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.

e With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

e With Windows 2000, clear the [Form feed] check box on the [NetWare Settings]
tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings]
tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows.

e With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

e With Windows 2000, clear the [Enable banner] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.

When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print.
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Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

& Note

O Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server. See p.77 “WINS”.

O Supported DHCP server is Windows NT 4.0 Server Service Pack 4 or later,
Windows 2000 Server and NetWare 5.

O If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so that the same IP address is assigned every time.

O DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

& Note
O The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

O You can confirm the current IP address on the configuration page. For more
information about the configuration page, see the Printer Reference.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartNetMonitor for Admin even under a DHCP environment.

This section describes how to configure the WINS server.

& Note

O The WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or
later, and Windows 2000 Servers WINS Manager.

O For more information about the WINS Server settings, see Windows Help.

O If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

O The NetBIOS name consists of up to 13 alphanumeric characters.
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Using a WWW browser

ﬂ Start the Web browser.

gPoint your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX XXX XXX XXX substituting the Xs with the IP address).

The status of the printer you chose appears on the Web browser.

B Click Network Config.
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click OK.

To use the factory default account, enter no user name and type "password"
for the password.

B ciick Tcpnp.

B Set WINS to active and enter the IP address of the WINS server in Primary
WINS Server and Secondary WINS Server.

ﬂ Click Refresh.

8 Exit the Web browser.

Using telnet

ﬂ Connect to the remote printer using telnet.

g Use the "set" command to make WINS active.

msh> set wins on

B Specify the IP addresses (primary and secondary) using the following com-
mands.

msh> wins primary Ipaddress msh> wins secondary Ipaddress

& Note
O To confirm the current configuration, use the "show" command.

ﬂ Log out from telnet.
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When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Client

When using IPP with SmartNetMonitor for Client, note the following;:

The network printer can only receive one print job from SmartNetMonitor for
Client at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Client tries to access the network printer until the retry
interval expires.

If SmartNetMonitor for Client cannot access the network printer and times
out, SmartNetMonitor for Client stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

If a print job that is sent from SmartNetMonitor for Client is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

If various users send print jobs using SmartNetMonitor for Client to network
printers, the printing order might not be in the order in which the jobs were
sent.

An IP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Client port name.



Specifications

Specifications

LAN interface 100BASE-TX, 10BASE-T, IP over 1394 *1
Frame type Ethernetll, IEEE802.2, IEEE802.3, SNAP

Protocol e TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

e IPX/SPX
NetWare 3.12,3.2,4.1,4.11,4.2,5, 5.1 IntranetWare

e NetBEUI 2
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

e IPP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

* AppleTalk
Mac OS5 8.6 ~9.1

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

"I The 1394 Interface Unit 4510 supports TCP/IP only.
"2 To use NetBEUI, use the SmartNetMonitor for Client port.
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